|
CALIBRATION PROCEDURE

NI PXI-5650/5691/5652

This document describes the processes to calibrate the

NI PXI-5650/5651/5652 RF signal generator. This document provides
performance tests to verify whether the instrument is performing within the
published specifications. For more information about calibration, visit
ni.com/calibration.
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Conventions

»

5

bold
italic

monospace

The following conventions are used in this manual:

The » symbol leads you through nested menu items and dialog box options
to a final action. The sequence File»Page Setup»Options directs you to
pull down the File menu, select the Page Setup item, and select Options
from the last dialog box.

This icon denotes a note, which alerts you to important information.

Bold text denotes items that you must select or click in the software, such
as menu items and dialog box options. Bold text also denotes parameter
names.

Italic text denotes variables, emphasis, a cross-reference, or an introduction
to a key concept. Italic text also denotes text that is a placeholder for a word
or value that you must supply.

Text in this font denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples.
This font is also used for the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names, functions, operations,
variables, filenames, and extensions.

Software Requirements

To calibrate the NI PXI-5650/5651/5652, you must install NI-RFSG
version 1.5 or later on the calibration system. You can download the latest
version of NI-RFSG at ni.com/idnet.

For more information about calibration VIs, refer to the NI RF Signal
Generators Help, which is accessible at Start»All Programs»
National Instruments»NI-RFSG»Documentation.

Table 1. Calibration File Locations (NI-RFSG 1.5 or Later)

File Name and Location Description

IVI\Bin\niRFSG.dl1l

NI-RFSG driver containing the entire NI-RFSG APL
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Documentation Requirements

You might find the following documentation helpful as you perform the
verification procedures:

* NI PXI-565X RF Signal Generator Specifications
* NI RF Signal Generators Getting Started Guide
* NI RF Signal Generators Help, including LabVIEW VI

programming references

These documents are installed with NI-RFSG. You can also download the
latest versions at ni.com/manuals.

Password

The default password for password-protected operations is NI.

Calibration Interval

The measurement accuracy requirements of your application determine
how often you should calibrate your device. NI recommends that you
perform a complete calibration for the NI 5650/5651/5652 at least once
a year. You can shorten this calibration interval based on the accuracy
demands of your application.

Test Equipment

Table 2 lists the equipment required to calibrate the NI 5650/5651/5652.
If you do not have the recommended equipment, select a substitute
calibration standard using the specifications listed in Table 2.
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Table 2. Required Equipment Specifications for NI 5650/5651/5652 Calibration

Required Recommended
Equipment Equipment Specifications

Spectrum analyzer Rohde & Schwarz Frequency range: 500 kHz to 9 GHz
(R&S) FSU Spectrum | Noise floor: <—150 dBm/Hz
Analyzer

Power meter Anritsu ML2438A Range: =70 dBm to +20 dBm
with a MA2472 diode | Frequency range: 10 MHz to 6.6 GHz
sensor Accuracy: 0.5%

Frequency reference Datum 8040 Frequency: 10 MHz
Rubidium Frequency | Frequency accuracy: 1 ppb (typically +5 E-11)
Standard

Test Conditions
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Follow these guidelines to optimize the connections and the environment
during calibration:

Keep cabling as short as possible. Long cables act as antennae, picking
up extra noise that can affect measurements.

Verify that all connections, including front panel connections and
screws, are secure.

Ensure that the PXI chassis fan speed is set to HI, that the fan filters
are clean, and that the empty slots contain filler panels. For more
information, refer to the Maintain Forced-Air Cooling Note to Users
document available at ni . com/manuals.

Keep relative humidity between 10% and 90%, noncondensing.
Maintain an ambient temperature of 23 °C +5 °C.

Allow a warm-up time of at least 30 minutes after the chassis is
powered on. The warm-up time ensures that the NI 5650/5651/5652
is at a stable operating temperature.

Each verification procedure requires a delay to be inserted in between
configuring all devices and acquiring the measurement. This delay
may need to be adjusted depending on the instruments used but should
always be at least 1,000 ms for the first iteration and 100 ms for each
subsequent frequency iteration.
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Calibration Procedures

The calibration process includes the following steps:

1.

Initial Setup—Install the device and configure it in Measurement &
Automation Explorer (MAX).

Verification—NVerify the existing operation of the device. This step
confirms whether the device is operating within its specified range
prior to adjustment.

Adjustment—Return the device to NI for a factory calibration to adjust
the calibration constants.

Reverification—Repeat the verification procedure to ensure that the
device is operating within its specifications after adjustment.

The verification procedure is described in more detail in the following
sections.

Initial Setup

Refer to the NI RF Signal Generators Getting Started Guide for
information about how to install the software and hardware and how to
configure the device in MAX.

Verification

This section describes the steps you must follow to verify the published
specifications for the NI 5650/5651/5652.

Verification tests the following NI 5650/5651/5652 specifications:

Frequency accuracy

High power level accuracy

Low power level accuracy

Single side-band phase noise at 10 kHz offset

Harmonics at less than or equal to O dBm output power level
Subharmonics at less than or equal to 0 dBm output power level

Nonharmonics at less than or equal to 0 dBm output power level
(1 kHz and 100 kHz offsets)

Verification of the NI 5650/5651/5652 is complete only after you have
successfully completed all tests in this section.

© National Instruments Corporation
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Verifying Frequency Accuracy

Complete the following steps to verify the frequency accuracy of the
NI 5650/5651/5652 module using a spectrum analyzer.

1. Connect the NI 5650/5651/5652 RF OUT front panel connector to the
spectrum analyzer RF INPUT front panel connector.

2. Connect the rubidium 10 MHz frequency reference signal to the
spectrum analyzer REF IN rear panel connector.

3. Configure the spectrum analyzer with the following settings:
e Center Frequency: 400 MHz
* Reference Level: =20 dBm
e Resolution Bandwidth: 100 Hz
e Span: 100 kHz
*  Reference Clock Source: External

4. Generate a signal after setting the following NI-RFSG property
settings:

e Frequency (Hz): 400 MHz

¢  Power Level (dBm): —20 dBm

*  Generation Mode: CW

*  Reference Clock Source: Onboard Clock

Use the spectrum analyzer to measure the frequency of the peak tone.

6. Verify that the measurement in step 5 is within the limits in Table 3,
with respect to 400 MHz.

Table 3. Frequency Accuracy Test Limit

Device Test Limit

NI 5650/5651/5652 9 ppm

Verifying High Power Level Accuracy

Complete the following steps to verify the high power level accuracy of the
NI 5650/5651/5652 module using a power meter.

1. Connect the NI 5650/5651/5652 REF IN/OUT front panel connector
to the rubidium 10 MHz frequency reference signal.

2. Connect the NI 5650/5651/5652 RF OUT front panel connector to the
power meter Sensor A.

3. Generate a single-tone signal after setting the following NI-RFSG
property settings:

e Frequency (Hz): 10 MHz
¢ Power Level (dBm): —35 dBm
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e Generation Mode: CW
¢  Reference Clock Source: Refln

4. Use the power meter to measure the RF OUT power. Compare the
measured RF OUT power to the Test Limit listed in Table 4.

5. Repeat steps 3 through 4 for every power level up to the Stop Power
level listed in Table 4, using a 5 dB step size.

6. Repeat step 5 for the remaining frequencies listed in Table 4.

Table 4. High Power Level Accuracy Test Points and Limits

Stop Power | TestLimit
Device Frequency (dBm) (dB)
NI 5650/5651/5652 10 MHz 5 +0.75
20 MHz 5
50 MHz 10
100 MHz 10
150 MHz 10
200 MHz 10
500 MHz 10
1 GHz 10
NI 5651/5652 1.5 GHz 10
2 GHz 10
2.5 GHz 10
3 GHz 10
3.3 GHz 7
NI 5652 3.5 GHz 7 +1.0
4 GHz 7
4.5 GHz 7
5 GHz 7
5.5 GHz 0
6 GHz 0
6.6 GHz 0
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Verifying Low Power Level Accuracy

Complete the following steps to verify the low power level accuracy of the
NI 5650/5651/5652 module using a power meter.

1. Connect the NI 5650/5651/5652 REF IN/OUT front panel connector
to the rubidium 10 MHz frequency reference signal.

2. Connect the NI 5650/5651/5652 RF OUT front panel connector to the

power meter Sensor A.

3. Generate a single-tone signal after setting the following NI-RFSG

property settings:

e Frequency (Hz): 10 MHz

¢  Power Level (dBm): —50 dBm
*  Generation Mode: CW

* Reference Clock Source: Refln

4. Use the power meter to measure the NI 5650/5651/5652 RF OUT
power. Compare the value to the Test Limits listed in Table 5.

Table 5. Low Level Accuracy Test Points and Limits

Stop Power | Test Limit
Device Frequency (dBm) (dB)
NI 5650/5651/5652 10 MHz -40 +1.8
20 MHz -40
50 MHz -40
100 MHz —40
150 MHz —40
200 MHz -40
500 MHz -40
1 GHz -40
NI 5651/5652 1.5 GHz -40
2 GHz —-40
2.5GHz -40
3 GHz -40
3.3 GHz -40
NI PXI-5650/5651/5652 Calibration Procedure ni.com



Table 5. Low Level Accuracy Test Points and Limits (Continued)

Stop Power | Test Limit
Device Frequency (dBm) (dB)
NI 5652 3.5GHz —40 +2.0
4 GHz -40
4.5 GHz -40
5 GHz —-40
5.5GHz —40
6 GHz —40
6.6 GHz —40

Repeat steps 3 though 4 for every power level up to the Stop Power
listed in Table 5, using a step size of 5 dB.

Repeat steps 3 though 5 with the remaining frequencies listed in
Table 5.

Verifying Single Sideband Phase Noise at
10 kHz Offset

Complete the following steps to verify the single sideband (SSB) phase
noise of an NI 5650/5651/5652 module using a spectrum analyzer.

1.
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Connect the NI 5650/5651/5652 RF OUT front panel connector to the
spectrum analyzer RF INPUT front panel connector.

Connect the NI 5650/5651/5652 REF IN/OUT front panel connector
to the rubidium 10 MHz frequency reference signal.

Connect the rubidium 10 MHz frequency reference signal to the
spectrum analyzer 10 MHz REF IN rear panel connector.

Generate a signal after setting the following NI-RFSG property
settings:

* Frequency: 1 GHz

*  Power Level: 0 dBm

*  Generation Mode: CW

*  Reference Clock Source: Refln

Configure the spectrum analyzer with the following settings:
*  Frequency: 1 GHz

*  Reference Level: 0 dBm

*  Resolution Bandwidth: 10 Hz
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9.

e Frequency Span: 100 Hz
e Reference Clock Source: External

Measure the maximum power within the configured span of the
spectrum analyzer and record this data. Reference this measurement
for steps 7 through 12.

Reconfigure the spectrum analyzer with the following settings:
e Frequency: 1 GHz + 10 kHz offset

e Reference Level: 0 dBm

*  Resolution Bandwidth: 10 Hz

e Frequency Span: 100 Hz

e Reference Clock Source: External

*  Trace Averaging: 20 traces

Measure the mean value within the configured span of the spectrum
analyzer and record this value.

Apply the following equation to the value measured in step 8:

phase noiseggp at 10 kHz offset = Measurement — 10log(RBW) — reference level

10.

Subtract the measurement recorded in step 6 from the value calculated
in step 9.

11. Verify that the value calculated in step 10 meets the Test Limits as
specified in Table 6.
12. Repeat steps 4 through 11 for the remaining frequencies listed in the
Frequency column in Table 6, if applicable to the device.
Table 6. Single Sideband Phase Noise at 10 kHz Offset
Frequency Test Limit
Device (GHz) (dBc/Hz)
NI 5650/5651/5652 1 <105
NI 5651/5652 2 <-98
3 <95
NI 5652 4 <-93
5 <90
6.6 <90

@ Note The main frequency synthesis occurs between 1.5 and 3.3 GHz using one of four
voltage-controlled oscillators (VCO). Frequencies outside this range are generated by
using dividers or multipliers. For frequencies lower than 1 GHz, the SSB phase noise can
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be characterized by the following relationship (use the 1 GHz measurement as your

reference):

SSB Phase Noisepgpr = SSB Phase Noisegprprence — 20log(n)

where  SSB Phase Noiserpsr = SSB phase noise at the center frequency of interest

in dBc/Hz

SSB Phase Noisepprrprence = SSB phase noise at the referenced center frequency
of interest in dBc/Hz

n = Reference/Test in Hz/Hz

Verifying Harmonics

Complete the following steps to verify the harmonic levels of the
NI 5650/5651/5652 module using a spectrum analyzer.

1.

© National Instruments Corporation

Connect the NI 5650/5651/5652 RF OUT front panel connector to the
spectrum analyzer RF INPUT front panel connector.

Connect the NI 5650/5651/5652 REF IN/OUT front panel connector
to the rubidium 10 MHz reference signal front panel connector.

Connect the rubidium 10 MHz reference signal to the spectrum
analyzer REF IN rear panel connector.

Generate a signal after setting the following NI-RFSG property
settings:

e Power Level (dBm): 0 dBm

*  Frequency (Hz): 10 MHz

*  Generation Mode: CW

*  Reference Clock Source: RefIn

Configure the spectrum analyzer with the following settings:
*  Center Frequency: 10 MHz

*  Reference Level: 0 dBm

*  Resolution Bandwidth: 1 kHz

*  Frequency Span: 500 kHz

*  Reference Clock Source: External

Measure the peak signal value of the fundamental frequency using the
current settings on the spectrum analyzer. Record this value.

Reconfigure the spectrum analyzer with the following settings:
*  Center Frequency: The center frequency from step 5 x 2.
*  Reference Level: 0 dBm

*  Resolution Bandwidth: 1 kHz
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e Frequency Span: 500 kHz

e Reference Clock Source: External

8. Measure the peak signal value of the 2nd harmonic using the settings
of the spectrum analyzer configured in step 7. Record this value.

9. Subtract the measurement in step 6 from the measurement in step 8.

10. Verify that the result calculated in step 9 meets the Test Limit of the
minimum difference from the generated signal power (dBc) as shown

in Table 7.

11. Repeat steps 4 through 10 for the remaining frequency points shown in

Table 7.

Table 7. Harmonics at Less Than or Equal to 0 dBm Output Power

Device

Frequency

Test Limit (dBc)

NI 5650/5651/5652

10 MHz

20 MHz

50 MHz

100 MHz

150 MHz

200 MHz

1 GHz

<-15

NI 5651/5652

1.5 GHz

2 GHz

2.5 GHz

3 GHz

3.3 GHz

<-25

NI 5652

3.5GHz

4 GHz

4.5 GHz

5 GHz

5.5GHz

6 GHz

6.6 GHz

<20

NI PXI-5650/5651/5652 Calibration Procedure
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Verifying Subharmonics on the NI 5652

Complete the following steps to verify the subharmonic levels of a
calibrated NI 5652 RF signal generator using a spectrum analyzer.

This verification is valid only for the NI 5652 RF signal generator.

1.

10.

© National Instruments Corporation

Connect the NI 5652 RF OUT front panel connector to the spectrum
analyzer RF INPUT front panel connector.

Connect the NI 5652 REF IN/OUT front panel connector to the
rubidium 10 MHz reference signal.

Connect one available end of the rubidium 10 MHz reference signal to
the spectrum analyzer REF IN rear panel connector.

Generate a single-sideband signal after setting the following NI-RFSG
properties:

Frequency (Hz): 3.3 GHz
Power Level (dBm): 0 dBm
Generation Mode: CW

Reference Clock Source: Refln

Configure the spectrum analyzer with the following settings:

Center Frequency: The frequency listed in Table 8
Reference Level: 0 dBm

Resolution Bandwidth: 1 kHz

Span: 500 kHz

Reference Clock Source: External

Measure the peak power of the fundamental tone using the spectrum
analyzer and record the value.

Reconfigure the spectrum analyzer with the following settings:

Center Frequency: Half the frequency used in step 5
Power Reference Level: 0 dBm

Resolution Bandwidth: 1 kHz

Span: 500 kHz

Reference Clock Source: External

Measure the peak power of the half harmonic using the spectrum
analyzer with the settings from step 7 and record the value.

Subtract the measurement in step 6 from the measurement in step 8.

Verify that the measured signal power in step 9 is within the Test Limit
specified in Table 8.
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11.

Repeat steps 4 through 10 for the remaining frequencies in Table 8.

Table 8. Subharmonics for the NI 5652

Subharmonic
Center Frequency Frequency Test Limit
(GHz) (GHz) (dBc)
33 1.65 <30
3.5 1.75
3.7 1.85
3.9 1.95
4.1 2.05 <25
43 2.15
4.5 2.25
4.7 2.35
4.9 2.45
5.1 2.55
53 2.65
5.5 2.75
5.7 2.85
59 2.95
6.1 3.05
6.3 3.15
6.5 3.25
6.6 33

Verifying Nonharmonics at Less than or
Equal to 0 dBm Output Power

Complete the following steps to verify the nonharmonic levels of an

NI 5
1.

650/5651/5652 module using a spectrum analyzer.

Connect the NI 5650/5651/5652 RF OUT front panel connector to the
spectrum analyzer RF INPUT front panel connector.

Connect the NI 5650/5651/5652 REF IN/OUT front panel connector
to the rubidium 10 MHz reference signal.

NI PXI-5650/5651/5652 Calibration Procedure 14 ni.com
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Connect one available end of the rubidium 10 MHz reference signal to
the spectrum analyzer REF IN rear panel connector.

Generate a signal after setting the following NI-RFSG property
settings:

*  Frequency (Hz): 35.125 MHz

e  Power Level (dBm): 0 dBm

*  Generation Mode: CW

*  Reference Clock Source: Refln

Configure the spectrum analyzer with the following settings:
*  Frequency: 35.125 MHz

*  Reference Level: 0 dBm

* Resolution Bandwidth: 1 kHz

e Span: 500 kHz

*  Reference Clock Source: External

Measure the peak power of the fundamental tone using the spectrum
analyzer and record the value. This value will be your reference value
for steps 7 through 15.

Reconfigure the spectrum analyzer with the following settings:
e Center Frequency: 35.125 MHz + 50.5 kHz offset

*  Power Reference Level: 0 dBm

*  Span: 99 kHz

*  Reference Clock Source: External

e Resolution Bandwidth: 100 Hz

Measure the peak power using the spectrum analyzer with the settings
from step 7 and record the value. This value is the highest peak
between 1 kHz and 100 kHz offset from the fundamental frequency.

Subtract the measurement in step 6 from the measurement in step 8.
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10. Verify that the result calculated in step 9 is within the >7 kHz Offset

limits listed in Table 9.

Table 9. Nonharmonics at Less Than or Equal to 0 dBm Output Power

Test Limits
RF Output > 1 kHz Offset > 100 kHz Offset
Frequency (dBc¢) (dBc¢)
500 kHz to 50 MHz <—65 <75
50 MHz to 3.3 GHz <—65 <70
3.3 GHz to 6.6 GHz <50 <-65

The following steps measure the nonharmonic levels freqOffset > 100 kHz
where freqOffset is the frequency offset from the tone being generated.

11. Configure the spectrum analyzer with the following settings:

e Center Frequency: 200 MHz

e Power Reference Level: 0 dBm
e  Resolution Bandwidth: 500 Hz
e Span: 100 kHz

e Reference Clock Source: External

12. Measure the peak power using the spectrum analyzer with the settings
from step 11 and record the value.

13. Subtract the measurement from step 12 from the measurement in

step 6.

14. Verify that the result is within the >700 kHz Offset limits specified in

Table 9.

15. Repeat steps 11 through 14 for the remaining frequencies listed in the
Test Point (MHz) column in Table 10.

Table 10. Test Points for Nonharmonic Test

Device

Test Point (MHz)

NI 5650/5651/5652

200

400

600

800

1,000

1,200

NI PXI-5650/5651/5652 Calibration Procedure
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Table 10. Test Points for Nonharmonic Test (Continued)

Device Test Point (MHz)
NI 5651/5652 1,400

1,600

1,800

2,000

2,200
2,400
2,600

2,800

3,000
3,200

NI 5652 3,400
3,600

3,800

4,000

4,200

4,400

4,600
4,800

5,000

5,200

5,400

5,600
5,800
6,000
6,200

6,400

6,600
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16. Repeat steps 4 through 15 using the Center Frequency (MHz) shown
in Table 11.

Table 11. Center Frequencies for Nonharmonic Test

Device Center Frequency (MHz)
NI 5650/5651/5652 35.125
1235.125
NI 5651/5652 3235.125
NI 5652 6535.125

NI PXI-5650/5651/5652 Calibration Procedure 18 ni.com



Where to Go for Support

The National Instruments Web site is your complete resource for technical
support. At ni.com/support you have access to everything from
troubleshooting and application development self-help resources to email
and phone assistance from NI Application Engineers.

A Declaration of Conformity (DoC) is our claim of compliance with

the Council of the European Communities using the manufacturer’s
declaration of conformity. This system affords the user protection for
electromagnetic compatibility (EMC) and product safety. You can obtain
the DoC for your product by visiting ni . com/certification. If your
product supports calibration, you can obtain the calibration certificate for
your product at ni . com/calibration.

National Instruments corporate headquarters is located at

11500 North Mopac Expressway, Austin, Texas, 78759-3504.

National Instruments also has offices located around the world to help
address your support needs. For telephone support in the United States,
create your service request at ni . com/support and follow the calling
instructions or dial 512 795 8248. For telephone support outside the United
States, contact your local branch office:

Australia 1800 300 800, Austria 43 662 457990-0,

Belgium 32 (0) 2 757 0020, Brazil 55 11 3262 3599,

Canada 800 433 3488, China 86 21 5050 9800,

Czech Republic 420 224 235 774, Denmark 45 45 76 26 00,
Finland 358 (0) 9 725 72511, France 01 57 66 24 24,

Germany 49 89 7413130, India 91 80 41190000, Israel 972 3 6393737,
Italy 39 02 41309277, Japan 0120-527196, Korea 82 02 3451 3400,
Lebanon 961 (0) 1 33 28 28, Malaysia 1800 887710,

Mexico 01 800 010 0793, Netherlands 31 (0) 348 433 466,

New Zealand 0800 553 322, Norway 47 (0) 66 90 76 60,

Poland 48 22 328 90 10, Portugal 351 210 311 210,

Russia 7 495 783 6851, Singapore 1800 226 5886,

Slovenia 386 3 425 42 00, South Africa 27 0 11 805 8197,

Spain 34 91 640 0085, Sweden 46 (0) 8 587 895 00,

Switzerland 41 56 2005151, Taiwan 886 02 2377 2222,

Thailand 662 278 6777, Turkey 90 212 279 3031,

United Kingdom 44 (0) 1635 523545

National Instruments, NI, ni.com, and LabVIEW are trademarks of National Instruments Corporation.
Refer to the Terms of Use section on ni . com/legal for more information about National
Instruments trademarks. Other product and company names mentioned herein are trademarks or trade
names of their respective companies. For patents covering National Instruments products/technology,
refer to the appropriate location: Help»Patents in your software, the patents . txt file on your
media, or the National Instruments Patent Notice at ni . com/patents.

© 2009 National Instruments Corporation. All rights reserved. 375104A-01 Jun09
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